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Introduction 
 
EVOSOFT is an application for computers with Windows operating system 
(see system requirements), which makes easier the programming of the 
data acquisition, from now on Datalogger, of your field meter FTE 
mediaMAX EVO, mediaMAX EVO S2, mediaMAX mini S, mediaMAX 
mini S2, mediaMAX mini ST or mediaMAX mini S2T. 
 
EVOSOFT allows automatizing your measurements, and it helps you in the 
creation of programs which you can save in your internal Database for 
future uses. 
 
To reach an optimal performance of EVOSOFT, knowing how to use the 
Datalogger of your field meter is necessary. Make sure that you have read 
all the functionalities of the Datalogger in the manual of your meter.  
 

 
 
The interaction between EVOSOFT and the meter is carried out through a 
USB Memory Device, like the one provided when the product is 
purchased. 
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Glossary 
 
This manual requires that the user have a good knowledge of how the 
meter works (FTE mediaMAX EVO, mediaMAX EVO S2, mediaMAX mini 
S, mediaMAX mini S2, mediaMAX mini ST or mediaMAX mini S2T), as 
well as basic notions about the Windows operative system, the one the 
document is being referred at any time. 
 
Find below the terminology used in this manual, which corresponds to the 
terms used in the Datalogger of the meter. 

 
• Program: Set of parameters of the meter, where one measurement is 

carried out, and it is stored as an element of the folder prog. 
 
• Measurement: Set of data of levels, powers or figures gathered by the 

meter for a concrete program, in a certain Point of Measurement. It’s 
stored like an element inside one subfolder measurement point.  

 
• Point of Measurement: Set of measurements carried out in a concrete 

point of the installation, which will be stored in one subfolder under the 
folder meas. 

 
• Group of Measurements: Structure that covers a group of programs 

and a group of measurements carried out in these programs in some 
points of the installation. In this structure also the number of repetitions 
is specified, as well as the time between repetitions, the pause 
between bands, etc. 

 
 
• Data-Logger: Utility of automatizing and controlling the capture of 

measurements, present in the meters FTE mediaMAX EVO, 
mediaMAX EVO S2, mediaMAX mini S, mediaMAX mini S2, 
mediaMAX mini ST and mediaMAX mini S2T. 
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Quick start 
 
To summarize the sequence of working is the following one: 
 
1. From EVOSOFT, the different parameters of the meter are selected for 

a set of measurements to be carried out. For this purpose, you can use 
the Assistant for creation of groups. The assistant will guide us to 
create the structure of the measurements, which is the base of the 
datalogger. This structure is made of 2 components: 

o A set of programs of measurement, where the parameters of 
the channels to be measured are specified. 

o The different points of measurement, which are the interesting 
places to measure the signal. 

 
2. Once the structure of measurements is created, it is dumped from 

the computer to the USB device. The memory is then connected to the 
meter, and through the command “New measurement” of the “TOOLS 
> DATALOGGER” menu, it executes all the programmed 
measurement procedures, storing the results in the same USB memory 
device.  

 
 
In the same manner, the meter can import the structure of measurement to 
its internal memory, to use it to carry out the measurements, and once they 
are over, to export the measurements to the USB memory device. In this 
case you might make sure the limitations imposed due to the capacity of 
the internal memory of the meter (see manual) that, for instance, does not 
allow storing the picture of the programs. 
 
 
3. The data, figures and pictures gotten, can then be loaded on the 

computer again, where EVOSOFT will allow its viewing and 
processing. Finally, the software allows generating detailed reports of 
the installations, which can be customized by the customer to make 
them fit with its needs. 
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Basic features 
 
EVOSOFT will make easier the following tasks: 
 
• Create structures of measurements to be used with the datalogger 

of the meter, and store them in the USB memory device. 
   
• Use assistants to create groups that compose the structure of the 

datalogger. 
 
• Save in a Data Base all the programming parameters, and reuse them 

in future works. 
 
• Restore the information of the datalogger from the USB memory, and 

view the measurements, the figures of the spectrums (in peak and 
average mode) the oscillogram of one specific CVBS line (for analogue 
TV) and one capture of a Picture of the TV channel. 

 
• Create customized reports from different patterns, which can be 

created or adapted with the pattern editor. 
 
• Create, Save and Restore programs that, without being part of the 

datalogger, they can be used by the meter in the program navigation 
mode. 
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 Installation and registering 

Content of the package 
 
The EVOSOFT packet is delivered into USB 2.0 memories, which must 
contain the following elements: 
• Installation software of EVOSOFT. 
• The current user’s manual in PDF format. 
• The needed firmware version to be able to use EVOSOFT with your 

field meter mediaMAX EVO, mediaMAX EVO S2, mediaMAX mini S, 
mediaMAX mini S2, mediaMAX mini ST or mediaMAX mini S2T.  

• The upgrading manual of your field meter. 
 

This memory can be used to the data transfer between the PC and the 
meter, as well as for other uses. 
It is highly recommended to save the information placed in the USB 
memory before using it as a storage data disk. 
 

Program requirements 
 
In order to make the program work properly, it is necessary: 
 
• One field meter mediaMAX EVO with a firmware version 5.8.0 or 

higher, or one mediaMAX EVO S2 with a firmware version 1.6.2 or 
higher or one mediaMAX mini S, mediaMAX mini S2, mediaMAX 
mini ST or mediaMAX mini S2T with a firmware version 1.4.3 or 
higher. 

• One Personal Computer (PC) with: 
o Windows 2000, Windows XP or Windows Vista Operative 

System.  
o Minimum 512 Mbytes of RAM memory and at least 50 Mbytes 

of free space in your Hard Disk.  
o It is recommended a Pentium 4 processor with 2.4 GHz or 

faster speed.  
o One USB port free, better with version 2.0, for better data flow. 
o Minimum screen resolution of 1024x768 pixels, with a colour 

depth of 16 bits, (we recommend a resolution of 1280x1024 
and a colour depth of 24 bits). 

• To dispose of Internet connection in order to carry out the activation of 
the software. 

• One USB 2.0 memory device to transfer and recover the information of 
the meter (delivered). 
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Installation 
To install this software, please connect your FTE Maximal USB stick 
which contains the EVO SOFT software. Connect to the USB port of 
your computer. If you have auto run enabled in your operating system, a 
new window appears, with different execution options. Select “Install 
EVOSOFT”. 
 

 
 

Otherwise, Open the USB stick and execute the program that appears in 
the EVOSOFT folder directly from the USB stick. 
 
Follow the instructions step by step until the Installation Wizard ends.  
 
 
Note for Windows 2000 and Windows XP users 
To be able to install and correctly register the software, you must have 
administrator permissions to install new software in your computer. 
 
 
Note for Windows Vista users 
 
If you have the User Accounts Control enabled, you might carry out the 
installation as Administrator. Open the folder EVOSOFT in the USB stick, 
and execute the installation program. Press the right button of the mouse to 
open the contextual menu and select the option “execute as administrator”. 
From now on, follow the instructions of the installation program. 
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Register 
After installing the EVO SOFT successfully: 
 
Before using any or all the functions of EVO SOFT, you must register 
the software. We require the software to be registered in order to 
avoid multiple copies of one Serial Number on different Computers. 
 
To register EVO SOFT, you need Internet connection. 
 

1. If the program has been installed correctly, when you start EVO 
SOFT, a new activation window appears: 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

ote
 
N : If the window shown above does not appear automatically, you can 
ccess to it by going to “Help  Get the key Code” a

 
 
 
 
 
 
 
 
 
 
 
 
 

Manual EVOSOFT Rev. 1.5 9 
 



2. Enter into the field the Serial Number provided by FTE 

3. Click on the “Next”

Maximal (labelled onto the box of the USB Device). 
 

 button. 

 

 

 
 
 
 

 
4. You will be then connected to the FTE Maximal Website. A new 

window will be opened in your Internet Browser with a website like 
the following one, where your Serial Number and your Register 
Key already appear (they do not need to be edited). 
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5. Enter your email Address in the concerning field. 

6. Click on the “Send”
 

 button. 

 
 

7. appears 

 

Once the entered information is verified, a new window 
showing your Activation Code, which automatically will be sent 

 the email address previously entered. 
 
Not

to

e: Take note of this Activation Code, since you will need it to 
act ate EVO SOFT (last step). 

 

Activate the Software 
The las tep is to activate EVO SOFT software. 
 

st enter the 

iv

t s

1. When you get the Activation Code (by email), you mu
Activation Code into EVO SOFT. To do it, select the option “Help 

 
 

 
 
 
 
 
 
 
 
 
 

 Enter the Key Code”. 
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2. Enter the Activation Code. 

 
3. Click on the “Activation” button. 

 
 
 
 
 
 
 
 
 
 
 

. re has been properly 

 
sat@ftemaxi

 
 
 
A message will then confirm that the softwa4
registered. Otherwise, please verify that you have typed your 
Activation Code correctly. If in any case, you cannot complete 
the process, please, contact Fte Maximal at

mal.com. 
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Configuration
 
As you ca  menu, you can 
accede to the Con w, you can specify the 
default lues which will appear in the different windows of EVOSOFT, as 
well as the fast acce utes of accessing to the 
documents, followin
 
 

 

n see in the following chapter, from the Tools
figuration window. In this windo

va
ss with the keyboard and ro

g the user’s preferences. 

 

Manual EVOSOFT Rev. 1.5 13 
 



Working environment 

3. Datalogger Tree structure 
4. List of programs 
5. Panel of data 
6. Status bar 

 
 
 

 
The main window of EVOSOFT is composed of the following main 
elements: 

 
1. Menu bar 
2. Tools bar, with fast access icons 

1

 

2

3

5

4

6 
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Menu bar 
 
This bar allows the access to the majority of the functionalities of the 
software. 
 

 
 

pen and save data. • File: accede to o
 

 
 

• View: allow adjusting the presentation of the viewed components, 
showing or hiding them, depending on e user’s preferences. 

 
 th
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• Datalogger: creation and management of groups, programs, 
rement points and other datalogger elements. measu

 

 
 
• Tools: creation and edition of reports and measurements utilities 
 

 
 
• Help: access to the manual, options of registering and credits. 
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Tools
 
In this bar, the most common functions of EVOSOFT appear. They are also 
accessible through the menu. 
 

 bar 

 
 
It is divided in 5 independent bars, with the following functions: 
 
• Standard 

o New datalogger Tree 
o Open Tree 
o Open recent Tree 
o Save in USB 

 
• Edit 

o Confirm changes 
o Cancel changes 

• e
o Spectrum in peak mode 
o Spectrum in average mode 

 
• Tools 

o Assistant for creation o fan ICT group 
o Assistant for creation of group 
o Edit the group using the assistant 
o Create report 

 
• Datalogger 

o Add/Delete/Duplicate group 

o Add/Delete/Delete_All the measurement points 
o Load group from the Data Base 
o Add programs from the Data Base 
o Save group in the Internal Data Base 

 
p ctrum S

o Add/Delete program 
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Datalogger panel 
 
This panel allows exploring the datalogger tree, composed by different 
groups of measurement. 
 

 
 
Each group older mode, which holds 
other tw o
The fold grams. One program is the 
set of p ter where the measurements will be done. In 

 parameters of frequency, band, modulation, standard, 
fe r, etc are specified, and they will 

keep sto
 
In the fo special interest 
are de easure the signal: before 
amplifyi  A folder is associated to 
each m tore the measurements, 
which are the acquired data for each program defined in prog.  
 
 
 
 

 of measurements is represented in f
o f lders, named prog and meas. 

s the different proer named prog show
arameters of the me

one program the
dif rent variables of the spectrum analyze

red in the folder meas.  

ld  named meas the points of the er installation with 
fined, where we have decided to m
ng, at the closest and farthest outlet, etc. 
easurement point, where the meter will s
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e, you can drag and drop elements and folders 
the tree, and towards the List of Programs. You 

 other programs of other folders prog. 
• Copy a measurement in a prog folder. Since the measurements 

store also the information of the program, you can transfer this 
information to a new program. 

• Drag one folder prog to/from the List of Programs 
 
Like in other Windows applications, using the right button of the Mouse, in 
this panel we accede to a contextual menu, which from we can carry out 
the basic management operations with groups, programs and 
measurement points. 
 

From the datalogger Tre
mong different parts of a

can, for instance: 
• Copy a program from one group to the other. 
• Add to a folder prog
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Data panel 
 
The at d a panel has three types of different viewing, associated to the tabs 
mar d avigate 
thro
see
the sele
 

ro  

ke  as Group, Program and Measurement. When you n
ugh the datalogger Tree, and you select different elements, you can 
 their content in this panel. The type of tab is automatically adapted to 

cted content. 

G up tab 
 

 
 
The options of pause, allow us to pause the meter when it detects we are 
changing the band in the automatic process of measurement; therefore the 
installer can change the input cable for the correct one at each time. 

ou should select the type of measurement to carry out between the
“Complete” and “Basic” options. 
The Repetition indicates the number of times that the measurement 
process will be done, while the Period establishes the waiting time 
between the repetitions, in minutes. 
You can find more details about these parameters in the chapter 
“Datalogger” in the user’s manual of your mediaMAX EVO or mediaMAX 
mini.  

Y  
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Program tab 

wn in this panel will change dynamically depending on the 
 

he options shoT
type of program selected, basically it depends on the Band (terrestrial, 
cable, satellite), and the carrier mode (analogue or digital modulation) that 
we select. 
In the following figure, the aspect of a program in terrestrial band and 
digital carrier is shown. 
 

 
 

The meaning of each parameter can be checked out in different chapters of 
the manual of your meter. 
 
 
 
 
Note: Setting to ‘1’ the value of the PIDs will force the meter to find them 
automatically. 
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Measurement tab 

ent inside the folder meas. 

 
Once the measurements have been carried out, and all the data have been 
imported from the meter, we can view the results comfortably, selecting the 
different measurements which remain stored in each subfolder of points of 
measurem
 

 
 
The data of the measurements are shown in 4 parts: measured values, 
pectrum figure, picture capture and selected video line figure. Each part 
xcept the one of measured values), can be dragged out of the 

s
(e
Measurement Tab, creating in this manner a new independent window, 
which can be maximized in order to observe it better. 
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Notes: 
• The figures allow the zoom function over a rectangular selection, 

 the axes x and y, dragging it while 
pressing the right button of the mouse. 

• The spectrum figure allow the combined viewing of the peak and 
average data, from the contextual menu, or through the icons: 

 

made pressing the left button of the mouse, and dragging over the 
area of interest. You can get back selecting in the opposite 
direction or from the contextual menu. 

• You can also shift the figure in
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Lis
 
This win
is to
diffe n
 
Thr
edit g e of 
the meter in your field work. 
 

t of programs 

dow is related to the programs menu of the meter. Its basic utility 
 keep a programs library that you can use in the future in the meter, in 
re t measurement scenarios. 

ough the list of programs you can explode the comfort and facility of 
programs with EVOSOFT, and you will reach taking advantagin

    
(Button of mediaMAX EVO or 

mediaMAX mini) 
 
 
 
From the contextual menu, where you can accede pressing the right button 
of your mouse inside this window, you can import or export the programs 
from/to the meter through a USB device, as well as store them in the Hard 
Disk of our computer. 
 
The programs of this window can be dragged to/from any other folder prog 
of a group of measurements. 
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Assistants 
 
The assistants are utilities that will guide you step by step during a process. 
In this case, the assistants will helps you to create or edit a group of 
measurements: 

- Assistant of creation of group. 
- Edit the group using the assistant.  
- Assistant of creation of new groups for ICT.1 

 

             
 
 
 
 
 
 

                                                      
1 Option only available in the version for Spain. 
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Create report 

This utility allows carrying out automatically detailed reports, following 
 

the default patterns established in EVOSOFT or other specify 
customized by the user. 

 

 
 

 
 
Depending on the kind of pattern selected, the software will generate a 
report with ‘doc’ extension that you will be able to see with the external 
editor or with the default Windows editor. 
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ext editor T

 
This
crea

ocu ssary for your projects. 

 tool gives the typical functionalities of a text editor, that you can use to 
te or modify the generated reports by EVOSOFT, or whatever other 
mentation which is neced
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Pattern editor 

• Type of pattern, which allows to select between “Special” and 
“Report”.(*) 

 
• Insert variables, which allows link to the pattern any of the 

imported values from the meter, as well as the administrative 
parameters. 

 
• Insert marks of repetitive block: the text that is involved between 

the marks will be repeated for each measurement you have 
selected to be included, making easy the creation of exhaustive 
reports. 

 
 

 
The pattern editor is a utility, with identical aspect than the Text Editor, but 
with the following features: 
 

 
 

                                                      
(*)  Option only available in the version for Spain. 
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 Example of use 

1 Select File > New 

2 istant of Creation of Groups from the Tools menu. 

 
Below, a typical sequence of use of EVOSOFT is described. 
 

 
Start the Ass

 

 
 

3 Assign a name to the group and fix the rest of parameters as you 
prefer. 

 
4 Click on Next. A new table appears, where you have to add the 

programs (channels) you want to measure on, with their 
appropriated options. You can recover from the internal Data Base 
programs that you could define in the past for other works. 
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5 Once all the programs are included, click on Next. A new 
ation of Group window appears then: Assistant of Cre

 

 
 

6 Select the number of measurement points that you want, and give 
them an appropriated name (FAR_OUTLET, INPUT_AMPLIFIER, 
etc…). Then, click End. 

 
7 With this, you have created your structure of measurements. You 

can revise and adjust with more detail the parameters of your 
programs navigating through the prog folder. 

 

 
8 Select in the Datalogger panel the created group. In this point, it is 

convenient to use the option Datalogger > Add Band Prefix in the 
name of the programs of the group, with which you will reach the 
meter to carry out the measurements in an order that minimizes the 
number of changes of band. 
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Select the option File > Save Datalogger in USB unit. 9 
 

 
 
 

10 Select the correct unit and click OK. 
 
11 In the USB unit, a log folder will appear, which contains our 

structure of measurements. Close the EVOSOFT, extract the 
USB(1)  and connect it to the meter.  

  
12 

 
                                                     

         
Go to the option TOOLS > DATALOGGER and select the option 
‘New Measure’. Select one of the points of measurements and 
press Start. 

 
1 Use the option ‘Extract hardware safety’ 
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13 The meter will carry out all the programmed measurement 
procedures, storing the results in the USB1. If you selected the 
option Pause between bands, the meter wil ow you 

4 When you finish the measurement process, the data, figures and 
pictures gotten are stored in the USB device. Take it off and 
connect it again to your computer. 

 
15 Ejecute EVOSOFT y desde Archivo>Abrir, seleccione la unidad 

USB adecuada y recupere la información de las medidas. 
 
16 Once the data is imported, EVOSOFT allow having an amazing 

viewing and handling. Into the folder meas of the Datalogger 
panel you will find subfolders with your point of measurements 
and, inside them, the particular data for each program. 

 
17 If you want, to make your reports clearer, it would be convenient to 

remove the prefix previously added in the step 8 to the program 
names and points of measurem nt.  

 
8 Navigate through the different measurements to verify the data are 

 
19  Create Report. 

      

l pause to all
change the connection when it is necessary. 

 
1

e

1
correctly captured. 

Create your own reports from Tools >
 
                                                

e same manner, the meter can import the structure of the 
ements to its

1 In th
measur  internal memory, store the measurements internally 
(see limitations of capacity) and, once the process is finished, export the 
measurements to the USB device. 
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In case of problems 
 
If you have any problem during the installation, or if you have any doubt 
about how the program works, please send an email with your contact data 
and the description of the problem to the email address which appears in 
the activation email, and we will be pleased to help you as soon as 
possible. 
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Copyright information 

r. It is expressly forbidden to copy, duplicate, sell or distribute in any manner this 
oduct without the previous written compliance of an authorized representing of the company 

 is also forbidden to subdue the software to inverse engineering processes, 
disassembling and decompiling, disallowing also any trial of acceding to the main code of the 
software. The translation or the creation of derived products based on this software is not 
allowed either. The licence of utilization and the user’s right to use the software will 
automatically expire in case of violation of any article of this Contract. 
 
WARRANTY  
Fte undertakes to replace the USB memory device which is delivered if the user detects any 
physical defect on it. 
 
NEGATION OF OTHER WARRANTIES 
The software as well as the manual are delivered “as they are”, without any expressed or 
limited warranty of any type – except the ones described in the paragraph above or the ones 
reflected in the manual by Fte, or by any person who has participated in the creation, 
production and distribution of the software, including (but not getting limited to them) the 
implicit warranties with commercial value and suitability for a specific purpose. The purchaser 
takes on all the risk concerned to the quality and performance of the software and of its user’s 
manual.  
 
RESPONSIBILITY LIMITATIONS 
Due to the purchaser’s acceptance all the risks related to the quality and suitability of this 
software, Fte takes on no responsibility, expressed or implicit, about the well working, 
performance or capacity of the application EVOSOFT to get adapted to the purchaser’s 
concrete necessities, declining therefore, any responsibility in front of any direct or indirect 
prejudge which comes out of its use. Fte will not take care of any damage, direct or indirect, 
accidental or consequent, derived of any defect of the software or of the manual, still being 
conscious of the possibility that these damages could happen. Apart from what was 
commented before, the concerning responsible people of Fte have contrasted and verified 
exhaustively the application EVOSOFT before its commercialization, being the outcome, in the 
subjective estimation of the authors, completely operative for the informatic mechanization and 
automatization of the related tasks for the utilization of the datalogger in your field meter 
mediaMAX EVO, mediaMAX EVO S2, mediaMAX mini S, mediaMAX mini S2, mediaMAX 
mini ST and mediaMAX mini S2T, and the presentation and generation of the reports with 
the stored measurements by the datalogger of your field meter. 
 
 
 
 
Microsoft, Microsoft Word and Windows are registered trademarks or commercial firms of 

Microsoft Corporation in the United States of North America and/or in other countries. 

 
 

 
The information contained in the User’s Manual as well as in the software are held to the 
author’s rights, represented by the company Fte Maximal (hereinafter Fte), who reserves the 
rights to make periodic modifications on this product without being obliged to notify these 
revisions to any person nor entity. The user will be able to operate with this software over only 
one compute
pr
Fte. It
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